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O presente manual elaborado pelas bibliotecas da Universidade de Aveiro (UA), é baseado no
Publication Manual Of The American Psychological Association: The Official Guide To APA Style, 7th
Edition e oferece um conjunto de diretrizes gerais para a realizacao de citagdes em texto e referéncias
bibliograficas.

O estilo APA (American Psychological Association) é um sistema de citagdo autor-data aplicado
na area das Ciéncias Sociais e Humanas.

Mais informacdo de apoio:

APA Style
APA Style Blog
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http://opac.ua.pt/cgi-bin/koha/opac-detail.pl?biblionumber=296973
http://opac.ua.pt/cgi-bin/koha/opac-detail.pl?biblionumber=296973
https://apastyle.apa.org/
https://apastyle.apa.org/blog/
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1 INDICACOESGERAIS

A informacdo que se segue pretende fornecer indicagdes e dicas importantes para a realizacdo de
citacOes em texto e das respetivas referéncias bibliograficas.

= Ainformacdo presente neste manual segue as indica¢des do Publication manual of the
American Psychological Association: the official guide to APA style, 7th edition, ndo tendo sido
realizadas adaptagdes;

= Ao longo dos exemplos apresentados neste manual, ndo foi considerada a tradugdo ou
adaptacao para portugués dos termos fixos na construcao de citacdes em texto e referéncias
bibliograficas (Ex. Master's thesis). Foram por isso aplicados os termos indicados pela APA 7ed.
Considera-se que os termos fixos podem figurar na lingua em que é escrito o documento,
sendo a traducao uma opcao do utilizador.

= As citacBes em texto e a lista de referéncias bibliograficas devem ser elaboradas de forma
consistente, sendo que as opg¢des tomadas relativas ao estilo a aplicar ou a adaptacao do
mesmo devem ser respeitadas ao longo de todo o documento, de forma a criar uniformidade
e clareza na estrutura;

= Sao varios os programas disponiveis para a gestao de referéncias bibliograficas que permitem
ao utilizador a insercao de citagdes em texto e a criacdo da lista de referéncias bibliograficas
de forma automatizada. Neste manual sdo apresentados exemplos dos formularios a preencher
no programa Mendeley para as diferentes tipologias de documentos. Para mais informacao
sobre o Mendeley consulte o ponto 4 deste manual.

2. CITACOES EM TEXTO

A citagcao em texto no estilo bibliografico APA 7ed assume a forma autor-data.

Uma citacdo é uma forma abreviada de fazer referéncia no texto a conteido de outro autor e deve
conter toda a informacdo necessaria para permitir uma correspondéncia inequivoca entre si e as
respetivas referéncias bibliograficas no final do documento.

Podem considerar-se trés formas de realizar as citagdes:

= citacao direta — transcricao literal do texto do autor;
o breve
o extensa

= citacdo indireta - transmissdo da ideia por palavras proprias;
= citacdo de citagao - quando ndo se tem acesso ao texto original.

Quanto ao formato, as citagdes no texto podem assumir dois formatos:

= entre paréntesis
= em narrativa
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Nas citacoes entre paréntesis, 0 nome do autor e a data de publicacdo aparecem entre paréntesis.

Exemplo: O consumidor tem vindo a alterar os seus padrdoes de consumo (Dionisio, 2009).

Nas citacoes em narrativa, o nome do autor é incorporado no texto como parte da frase, seguido
do ano entre paréntesis.

Exemplo: De acordo com Dionisio (2009) o consumidor tem vindo a alterar os seus padrdes de
consumo.

Nota: Em alguns casos, o autor e a data podem aparecer incorporados no texto. Nesse caso, ndao
utilizar paréntesis.

Exemplo: Em 2009, Dionisio observou que o consumidor tem vindo a alterar o seu padrao de
consumo.

2.1 A regra

Segundo o estilo bibliografico APA 7ed a citacdo em texto segue as seguintes regras:

a) O sistema de citacdo usado é autor-data, sendo que os elementos devem ter a seguinte
ordem:
o apelido do autor, ano de publicacdo do documento e, tratando-se de uma citacao direta,
0s numeros das paginas citadas;
o ainformacdo é colocada entre paréntesis curvos.

b) No caso da introducdo de mais do que uma citagdo ao mesmo tempo, cada citagdo é separada

por ponto e virgula e sdo ordenadas alfabeticamente pelo apelido do autor, sendo que sao
incluidas todas as citacdes num Unico paréntesis curvo.

Exemplo:

a) (Silva, 2010, p. 25)

b) (Craik & Lockhart, 1972; Goldfried, 2013; Pacula et al., 2014)

2.2 Autoria na citacao

Segundo a APA 7ed as normas para a citacdo de autores no texto variam segundo o nimero de autores
da obra citada;

A informacao da autoria pode figurar na citagdo em texto dentro de paréntesis ou fora dos mesmos.
Os exemplos que se seguem apresentam as regras para apresentacdo da autoria na citacdo em texto
no formato entre paréntesis e em formato de narrativa:
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Autoria

Citacao entre paréntesis

Citacao em narrativa

Um autor

(Luna, 2020)

Luna (2020)

Dois autores

(Salas & D'Aqostino, 2020)

Salas and D'Aqgostino (2020)

Trés ou mais autores

(Martin et al., 2020)

Martin et al. (2020)

Grupos como autores, com
abreviatura (instituicoes,
organizagoes, etc.)

Primeira citacao

Citacbes seguintes

(National Institute of Mental
Health [NIMH], 2020)

(NIMH, 2020)

National Institute of Mental
Health (NIMH, 2020)

NIMH (2020)

Grupos como autores, sem
abreviatura

(Stanford University, 2020)

Stanford University (2020)

Sem indicacao de autoria:

i) A citacdo em texto é efetuada
através das primeiras palavras da
entrada da referéncia (normalmente
parte do titulo da obra) e o ano;

ii) Utilizam-se as aspas: para titulos
de artigos, capitulos ou paginas web;

iii) Utiliza-se o italico: para titulos de
revistas, livros, brochuras, relatérios.

(“Study Finds,” 2007)
(College Bound Senior, 2008)

“Study Finds” (2007)
College Bound Senior (2008)

Autoria andnima

Nos casos em que o proprio
documento refere autor
desconhecido

(Anonymous, 1998)

(Anonymous, 1998)
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2.3 Citagoes ambiguas

Autoria

Regra

Exemplo

Trés ou mais
autores

Se duas referéncias com trés ou mais
autores se abreviam da mesma
maneira devem ser citados os
apelidos dos autores necessarios
para as distinguir

Jones, Smith, Liu, Huang, and Kim
(2020)

Jones, Smith, Ruiz, Wang, and Stanton
(2020)

ou

(Jones, Smith, Liu, et al., 2020)

(Jones, Smith, Ruiz, et al., 2020)

Trés ou mais
autores

Quando apenas o apelido do autor
final é diferente, devem ser citados
os apelidos de todos os autores

Hasan, Liang, Kahn, and Jones-Miller
(2015)

Hasan, Liang, Kahn, and Weintraub
(2015)

Autores com o
mesmo apelido

Se a lista de referéncias inclui
publicacbes de dois ou mais autores
com o mesmo apelido, inclua as
iniciais dos autores com o mesmo
apelido em todas as citacdes do
texto, mesmo se o ano de
publicacao for diferente.

(C. Costa, Santos & Ramalho, 2010; P. J.
Costa, Heleno & Pinhel, 2010)

ou
C. Costa, Santos and Ramalho (2010)

and P. J. Costa, Heleno and Pinhel
(2010)

Autores com o
mesmo apelido e
as mesmas
iniciais

Inclua o nome dos autores com o
mesmo apelido e iniciais em todas as
citagdes do texto, mesmo se o0 ano
de publicacado for diferente.

(Paul Janet, 1876 & Pierre Janet, 1906)
ou

Paul Janet (1876) and Pierre Janet
(1906)

Dois ou mais
trabalhos de
autores
diferentes

entrada por ordem
alfabética do
apelido do autor

(Apelido do autor A, Ano do
documento; Apelido do autor B,
Ano do documento)

ou
Apelido do autor A (Ano do

documento) and Apelido do autor B
(Ano do documento)

(Sousa, 2010; Vieira, 2002)

ou

Sousa (2010) and Vieira (2002)
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Autoria Regra Exemplo

Documentos do (Apelido do autor, Ano do (Alves, 1984a, 1984Db)
mesmo autor documentoa, Ano do documentob)

com a mesma

data ou ou

acrescenta-se ao Apelido do autor (Ano do

icaca Al 1984a, 1984b
ano de publicacdo | documentoa, Ano do documentob) ves ( @ )

uma letra (a, b, c,
etc)

2.4 Citacoes indiretas

A reproducdo da ideia de outros autores por palavras proprias e diferentes dos mesmos designa-se
por citacdo indireta.

O reescrever de uma ideia de um autor por palavras proprias é o tipo de citagdo mais frequente ao
longo de um documento e deve ser sempre acompanhada dos devidos créditos ao autor do
documento consultado.

Segundo a APA 7ed, a transmissao do conhecimento dos autores dos documentos consultados deve
ser sempre acompanhada da citacdo ao mesmo, ou seja a referéncia em texto ao Apelido do autor,
Ano de publicacéo e a localizacdo (paginas).

Para aplicacdo correta das regras genéricas de citacdo em texto consulte os pontos 2.1, 2.2 e 2.3 deste
manual.

2.5 Citacgoes diretas

A incluséo da transcrigao literal do texto do autor do documento consultado designa-se por citagcao
direta, que pode ser utilizada de duas formas: breve e extensa.

Segundo a APA 7ed, sao aplicadas as seguintes regras:
Citacao direta breve
o Transcricao literal do texto do documento consultado que nao exceda as 40 palavras;

o A transcricdo € inserida no proprio texto, entre aspas;
o Deve incluir a indicagdo da pagina (p.) ou o intervalo das paginas (pp.).

Citacao direta extensa
o A citagdo direta extensa define a transcricdo literal do texto do documento consultado com
mais de 40 palavras;

o Atranscricdo é destacada do texto com avango da margem esquerda (0,5 polegadas =
1.27cm) para todas as linhas com espagamento duplo entre linhas;
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o Se forem transcritos dois ou mais paragrafos de texto a primeira linha do 2° paragrafo e

seguintes é colocada com um avancgo de mais 0,5” polegadas (1.27cm);

o Deve incluir a indicagdo da pagina (p.) ou o intervalo das paginas (pp.).

texto transcrito do documento
consultado com 40 ou mais
palavras. (Apelido do autor,

ANo, p. XXX OU PP. XXX-XXX)

Citacoes Regra Exemplo

diretas

breves Texto que estamos a redigir (...) "librarians must be willing to expose themselves
“texto transcrito do documento | to the discomfort of advocacy, argument, criticism,
consultado” (Apelido do autor, and real change to be in the forefront of this
ANO, p. XXX OU PpP. XXX-XXX). movement” (OgBurn, 2009, p.41).
ou ou
Texto que estamos a redigir (...) como refere OgBurn (2009) ao debrucar-se
Apelido do autor (ano) “texto sobre esta problematica: “librarians must be willing
transcrito do documento to expose themselves to the discomfort of
consultado” (p. xxx ou pp. Xxx- advocacy, argument, criticism, and real change to
XXX). be in the forefront of this movement” (p.41).

Extensas Texto que estamos a redigir. A personalizacao de servicos ligada ao alojamento

de revistas é uma solucdo amplamente usada.

They are focusing on the capabilities and
possibilities of new models rather than slavishly
duplicating or simply automating traditional
models. Aware there are core services
underpinning both traditional and new model
publishing activities, publishing programs are
concentrating on defining that minimum set

and learning what is required to support it.

At the same time, they seek to identify the
most promising new kinds of services needed to

support authors and editors. (Hahn, 2008, p. 16)
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Citacoes Regra Exemplo
diretas

extensas ou ou

Texto que estamos a redigir De acordo com Vieira (2002):

Apelido do autor (ano):
O estudo do comportamento do

texto transcrito do documento : g : L
consumidor € definido como a investigacao

consultado com 40 ou mais .. ) )
das atividades diretamente envolvidas em

palavras. (p. 0xx Ou pp. XxX-Xxx) obter, consumir e dispor de produtos e
servicos, incluindo os processos decisorios
que antecedem e sucedem estas a¢oes. Na
verdade é o estudo do processo vivido
pelos individuos ao tomarem decisdes de

empregar seus recursos disponiveis em

itens relacionados ao consumo. (p. 219)

2.6 Citacao de citacao

A referéncia a documentos originais que ndo foram consultados, mas dos quais se obteve
informacao através da leitura de outros documentos (secundarios), designa-se por citacdao de citagcao
e segue a seguinte regra:

Regra Exemplo

indicacdo do Autor (documento original) e | (Adams, 2017, as cited in Smith, 2005)
da informacao que pretende salientar
precedida da expressao (as cited in

Apelido, Ano). ou

Adams asserts in her book Chicken Little that "without a
doubt, the chicken came before the egg" (as cited in
Smith, 2005).

A APA nédo aconselha a utilizacdo de fontes secundarias, a menos que o trabalho original ndo esteja
disponivel.

Nota: na lista de referéncias bibliograficas é incluida apenas a referéncia da fonte que consultou.
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3. REFERENCIAS BIBLIOGRAFICAS

As referéncias bibliograficas apresentam os detalhes da publicagdo, de forma a permitir uma
identificacdo inequivoca dos documentos.

Cada referéncia inclui a informagao prevista pelo estilo bibliografico em uso que permita a identificagdo e
localizacdo do documento consultado. Os dados a incluir variam de acordo com o tipo de publicacao.

3.1 A regra

Para a realizagdo da lista de referéncias bibliograficas, segundo a APA 7ed, devem ser seguidas as
seguintes indicagoes:

o A lista de referéncias bibliograficas deve figurar no final do documento que se encontra a
redigir;

o A lista de referéncias bibliograficas deve ser organizada por ordem alfabética do Apelido do
primeiro autor de cada uma das referéncias;

o Apenas figuram na lista de referéncias bibliograficas os documentos citados ao longo do texto,
sendo que todas as entradas de citagdes no texto devem corresponder a uma referéncia
bibliografica;

o Nao deve ser incluida comunicagdo pessoal, como correspondéncia, memorandos ou registos
de comunicacdo eletronica informal na lista de referéncias bibliograficas (exemplo: e-mails,
mensagens em chats, entrevistas pessoais, etc.);

o A primeira letra do Titulo e Complemento do titulo deve ser capitalizada;

o A consisténcia é importante na elaboracdo da lista de referéncias bibliograficas, sendo que a

informacdo e o detalhe dos dados de cada uma das referéncias bibliograficas deve ser
uniforme.

Exemplo:

Ashwin, P. (2006). Changing higher education: The development of learning and teaching.
Routledge.

Barlow, D. H. (2014). Clinical handbook of psychological disorders: A step-by-step treatment manual.
The Guilford Press. http://books.google.pt/books?id=FCTyAgAAQBAJ

Craik, F., & Lockhart, R. (1972). Levels of processing: A framework for memory research. Journal of
Verbal Learning and Verbal Behavior, 11(6), 671-684. https://doi.org/10.1016/S0022-
5371(72)80001-X
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http://books.google.pt/books?id=FCTyAgAAQBAJ
https://doi.org/10.1016/S0022-5371(72)80001-X
https://doi.org/10.1016/S0022-5371(72)80001-X

3.2 Autoria nas referéncias bibliograficas

Autoria Regra Exemplo
1 autor Apelido, Iniciais do autor Barlow, D. H. (2014). Clinical handbook of
psychological disorders: A step-by-step treatment
manual. The Guilford Press.
http://books.google.pt/books?id=FCTyAgAAQB
AJ
2a?20 Apelido, Iniciais de todos os Watson, S., Gunasekaran, G., Gedye, M., van Roy,
autores autores Y., Ross, M., Longdin, L., & Brown, L. (2003). Law
of business organisations (4th ed.). Palatine Press.
Indicar todos os autores até 20
inclusivé. O ultimo autor é precedido
de &.
21 ou mais | Apelido, Iniciais do autor 1 até Loannidis, N. M., Rothstein, J. H., Pejaver, V.,
autores Apelido, Iniciais do autor 19, ... Middha, S., McDonnell, S., Baheti, S. Musolf, A.,
Apelido, Iniciais do Gltimo autor Li, Q. Holzinger, E., Karyadi, D., Cannon-Albright,
L., Teerlink, C, C,, Stanford, J. L., Isaacs, W. B., Xu,
Indicar os primeiros 19 autores, J..Cooney, K, Lange, E., Schleutker, J., Carpten, J.
inserir reticéncias e o ultimo autor D., ... Weiver, S. (2016). Revel: An ensemble
method for predicting the pathogenicity of rare
missense variants. American Journal of Human
Genetics, 99(4) 877-85.
https://doi.org/10.1016/j.ajhg.2016.08.016
Grupos Nome do Grupo American Psychological Association. (2010).
como ] ] . Publication manual of the American
autores Indicar a designacao completa do Psychological Association. APA.

(instituicdes,

organizagdes,

nome do grupo na lista das
referéncias (ndo usar a
sigla/abreviatura)

etc.)

Sem Titulo do documento Six sites meet for comprehensive anti-gang
indicagao initiative conference. (2006). OJJDP News @ a
de autoria Glance.

https://www.ncjrs.gov/html/ojjdp/news at glanc
e/216684/topstory.html
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http://books.google.pt/books?id=FCTyAgAAQBAJ
http://books.google.pt/books?id=FCTyAgAAQBAJ
https://doi.org/10.1016/j.ajhg.2016.08.016
https://www.ncjrs.gov/html/ojjdp/news_at_glance/216684/topstory.html
https://www.ncjrs.gov/html/ojjdp/news_at_glance/216684/topstory.html

3.3. Referéncias bibliograficas por tipologia de documento

Os elementos que constituem cada uma das referéncias bibliograficas variam consoante a tipologia
de documento e o formato do mesmo (impresso ou digital).

Neste manual sdo consideradas as seguintes tipologias de documentos:

Artigo cientifico

Livro

Capitulo de livro

Comunicacao em conferéncia

Dissertacao de mestrado e Tese de doutoramento
Legislacao

Site Web

Post em blogue

Para cada tipologia indicada nos quadros seguintes, sdo apresentados:

Os elementos que compdem a referéncia bibliografica;
Um exemplo de apresentacao da referéncia bibliografica;
Os campos a preencher no formulario do Mendeley.

3.3.1 Em formato digital

Artigo cientifico Apelido, Inicial do nome. (Ano). Titulo do artigo. Titulo da revista,
eletréonico volume(numero), paginas xx-xx. https://doi.org/xxxx (preferencial) ou

https://xxxx

Exemplo:
Goldfried, M. R. (2013). What should we expect from psychotherapy? Clinical
Psychology Review, 33(5), 862-869. https://doi.org/10.1016/].cpr.2012.09.006

No Mendeley:

Para um artigo cientifico eletronico, preencha os seguintes campos:

Pages: 862-869
DOI: https://doi.org/10.1016/j.cpr.2012.09.006
URL: http://www.ncbi.nlm.nih.gov/pubmed/23628909

o Type: Journal Article

o Title: What should we expect from psychotherapy?
o Authors: Goldfried, M. R.

o Journal: Clinical Psychology Review

o Year: 2013

o Volume: 33

o lIssue:5

O

O

O
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https://doi.org/xxxx
https://xxxx/
https://doi.org/10.1016/j.cpr.2012.09.006
https://doi.org/10.1016/j.cpr.2012.09.006
http://www.ncbi.nlm.nih.gov/pubmed/23628909

Livro eletronico

Apelido, Inicial do nome. (Ano). Titulo do livro. (nimero da edicdo). Editor
comercial. https://doi.org/xxxx (preferencial) ou https://xxxx

Exemplo:
Antonelli, G. (2006). Underwater robots: Motion and force control of vehicle-
manipulator systems (2nd ed.). Springer. https://doi.org/10.1007/11540199

No Mendeley:
Para um livro eletrdnico, preencha os seguintes campos:

Type: Book

Title: Underwater robots: Motion and force control of vehicle-
manipulator systems

Authors: Gianluca Antonelli

Year: 2006

Edition: 2

Publisher: Springer

DOI: https://doi.org/10.1007/11540199

URL: http://link.springer.com/10.1007/11540199

O O O O O O

Capitulo de livro
eletrénico

Apelido, Inicial do nome do autor do capitulo. (Ano). Titulo do capitulo do
livro. In Inicial do Nome. Apedido do editor literario do livro (Ed. ou Eds.),
Titulo do livro (pp. xx-xx). Nome do editor comercial. https://doi.org/xxxx ou
https://xxxx

Exemplo:

Rhodes, R. A. W. (2007). Blair and governance. In R. Koch & J. Dixon (Eds.),
Public governance and leadership (pp. 95-116). DUV.
https://doi.org/10.1007/978-3-8350-9100-9 5

No Mendeley:
Para um capitulo de livro eletronico, preencha os seguintes campos:

Type: Book section

Title: Blair and governance

Authors: R. A. W. Rhodes

Book: Public governance and leadership

Year: 2007

Edition:

Publisher: DUV

Pages: 95-116

Editors: R. Koch, J. Dixon (um editor por linha)
DOI: https://doi.org/10.1007/978-3-8350-9100-9 5

O o O O O O O o o ©o
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https://doi.org/xxxx
https://xxxx/
https://doi.org/10.1007/11540199
https://doi.org/10.1007/11540199
http://link.springer.com/10.1007/11540199
https://xxxx/
https://doi.org/10.1007/978-3-8350-9100-9_5
https://doi.org/10.1007/978-3-8350-9100-9_5

Comunicacao
eletronica em
conferéncia

Para uma comunicagao publicada em formato de artigo cientifico, livro ou
capitulo de livro eletronico, deve seguir as indicagdes mencionadas neste
tutorial para a respetiva tipologia de documento.

Sessdao / Comunicacao / Poster em conferéncia

Apelido, Inicial do nome do autor. (Ano, Més Dia-Més Dia). Titulo da
comunicagdo [Conference session ou Paper presentation ou Poster
presentation]. Nome da conferéncia, Local. https://doi.org/xxxx ou

https://xxxx.

Exemplo:

Rutledge, L., LeMirg, S., & Mowdood, A. (2015, March 25-28*). Dare to
perform: Using organizational competencies to manage job performance*
[Paper presentation]. Association of College & Research Libraries 2015
Annual Conference, Portland, OR, United States*.
http://www.ala.org/acrl/sites/ala.org.acrl/files/content/conferences/confsand
preconfs/2015/Rutledge LeMire Mowdood.pdf

No Mendeley:

Para sessao / comunicagado / poster em conferéncia online, preencha os
seguintes campos:

Type: Conference Proceedings
Title: Dare to perform: Using organizational competencies to
manage job performance [Paper presentation]

o Authors: Rutledge, L., LeMire, S., & Mowdood, A. (um autor por
linha)

o Proc. Title: Association of College & Research Libraries 2015 Annual
Conference, Portland, OR, United States.
Year: 2015
URL:
http://www.ala.org/acrl/sites/ala.org.acrl/files/content/conferences/c
onfsandpreconfs/2015/Rutledge LeMire Mowdood.pdf

*Nota: Ao finalizar o documento word, apds quebrar as ligacdes ao
Mendeley, é necessario corrigir trés elementos na referéncia bibliografica:

- no paréntesis do ano, é necessario colocar o més e o dia. Exemplo: (2016,
March 30-April 2) ou (2019, May 20-22)

- colocar italico no titulo da Sessao / Comunicagdo / Poster

- retirar o italico do Nome da conferéncia, Local.
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https://xxxx/
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Dissertacao de
mestrado e tese
de doutoramento
eletrénica

No Mendeley, é
necessario efetuar a
seguinte ativagao:

Menu Tools >
Options,

Document type:
Thesis

ativar os campos:
"Genre" e
"Publisher” > Apply >
Ok.

Publicadas em bases de dados ou disponiveis em repositorios

Apelido, Inicial do nome do autor. (Ano). Titulo da dissertacdo de mestrado
ou tese de doutoramento [Master’s thesis ou Doctoral dissertation, Nome da
Instituicdo]. Nome da base de dados ou repositorio. http://xxx

Exemplo:

Almeida, A. C. P. de. (2019). Implementacdo de uma academia de
conhecimento em contexto industrial: Uma proposta metodoldgica [Master's
thesis, Universidade de Aveiro]*. Repositorio Institucional da Universidade de
Aveiro. https://ria.ua.pt/handle/10773/26809

No Mendeley:

Para uma dissertacdo de mestrado ou tese de doutoramento eletronica,
preencha os seguintes campos:

Type: Thesis

Title: Implementacdo de uma academia de conhecimento em
contexto industrial: Uma proposta metodoldgica

Authors: Almeida, A. C. P. de.

Year: 2019

Genre: Master’s thesis, Universidade de Aveiro

Publisher: Repositorio Institucional da Universidade de Aveiro
URL: https://ria.ua.pt/handle/10773/26809

O O O O O

*Nota: Ao finalizar o documento word, apos quebrar as ligacdes ao
Mendeley, é necessario corrigir a referéncia, alterando a posi¢do do
paréntesis reto conforme o exemplo apresentado.

Legislacao

No Mendeley, é
necessario efetuar a
seguinte ativacao:

Menu Tools >
Options,

Document type:
Statute

ativar o campo
"Publication” > Apply
> Ok.

Uma vez que o estilo bibliografico APA 7th ndo menciona como proceder
para legislacdo de outros paises que ndo os EUA, o que apresentamos de
seguida é apenas uma sugestdo para:

Lei / Decreto-lei / Despacho/Portaria
Exemplo:

Despacho n.° 17169/2011 do Ministério da Educacao e Ciéncia.* (2011).
Diario da Republica: Il série, n.° 245. https://dre.pt/application/file/1010956
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No Mendeley:

Para uma Lei, Decreto-lei, Despacho ou Portaria, preencha os seguintes
campos:

Type: Statute
Title: Despacho n.< sup>o< /sup> 17169/2011 do Ministério da
Educacéo e Ciéncia
o Publication: Diario da Republica: Il série, n.° 245
Year: 2011
URL - https://dre.pt/application/file/1010956

*Nota: ao finalizar o documento word, ap6s quebrar as ligagdes ao
Mendeley, é necessario corrigir a referéncia, retirando a virgula e colocando
um ponto, conforme o exemplo apresentado.

O cédigo de HTML no campo Title serve para formatar o caractere
sobrescrito do titulo - n.< sup>o< /sup> = n.°

Site web

No Mendeley, é
necessario efetuar a
seguinte ativacao:

Menu Tools >
Options:

Document type:
Web Page

e "Month” > Apply >
Ok

ativar o campo "Day”

Apelido, Inicial do nome do autor ou nome da instituicdo/organizacao. (Ano,
Més dia). Titulo do documento. Nome do site*. https://xxxx

* Omitir este elemento quando o autor e o nome do site (Publication)
tiverem o mesmo nome.

Exemplo de pagina web com autoria de uma instituicao/organizacao:
Universidade de Aveiro. (2020). Apoio ao ensino. https://www.ua.pt/pt/apoio-
ensino

Exemplo de pagina web com autoria individual:
Giovanetti, F. (2019, November 16). Why we are so obsessed with personality
types. Medium. https://medium.com/the-business-of-wellness/why-we-are-
so-obsessed-with-personality-types-577450f9aee9

No Mendeley:
Para uma pagina Web, preencha os seguintes campos:

Type: Web Page

Authors: Giovanetti, F.

Title: Why we are so obsessed with personality types

Year: 2019

Publication: Medium

Day: 16

Month: November

URL: https://medium.com/the-business-of-wellness/why-we-are-so-
obsessed-with-personality-types-577450f9aee9

O O O o 0O 0O 0O O

Pagina 18



https://dre.pt/application/file/1010956
https://xxxx/
https://www.ua.pt/pt/apoio-ensino
https://www.ua.pt/pt/apoio-ensino
https://medium.com/the-business-of-wellness/why-we-are-so-obsessed-with-personality-types-577450f9aee9
https://medium.com/the-business-of-wellness/why-we-are-so-obsessed-with-personality-types-577450f9aee9
https://medium.com/the-business-of-wellness/why-we-are-so-obsessed-with-personality-types-577450f9aee9
https://medium.com/the-business-of-wellness/why-we-are-so-obsessed-with-personality-types-577450f9aee9

Post em blogue Apelido, Inicial do nome do autor. (Ano, Més Dia). Titulo do post. Nome do

blogue. http://xxxx

Exemplo:
McAdoo, T. (2019, November 7). How many names to include in an APA style
reference. APA Style. https://apastyle.apa.org/blog/more-than-20-authors

No Mendeley:
Para um post em blogue, preencha os seguintes campos:

Type: Magazine Article

Title: How many names to include in an APA style reference
Authors: McAdoo

Publication: APA Style

Year: 2019

Day: 7

Month: 11

URL: https://apastyle.apa.org/blog/more-than-20-authors

O O 0O 0O O O O
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3.3.2 Em formato impresso

Artigo cientifico Apelido, Inicial do nome. (Ano). Titulo do artigo. Titulo da revista,
volume(numero), paginas Xx-xx.

Exemplo:
Goldfried, M. R. (2013). What should we expect from psychotherapy? Clinical
Psychology Review, 33(5), 862—-869.

No Mendeley:

Para um artigo cientifico, preencha os seguintes campos:

o Type: Journal Article
o Title: What should we expect from psychotherapy?
o Authors: Goldfried, M. R.
o Journal: Clinical Psychology Review
o Year: 2013
o Volume: 33
o lIssue: 5
o Pages: 862-869
Livro Apelido, Inicial do nome. (Ano). Titulo do livro. (nimero da edigdo). Editor.
Exemplo:

Antonelli, G. (2006). Underwater robots: Motion and force control of vehicle-
manipulator systems (2nd ed.). Springer.

No Mendeley:
Para um livro, preencha os seguintes campos:

o Type: Book

Title: Underwater robots: Motion and force control of vehicle-
manipulator systems

Authors: Antonelli, Gianluca

Year: 2006

Edition: 2

Publisher: Springer

O

O O O O
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Capitulo de livro

Apelido, Inicial do nome do autor do capitulo. (Ano). Titulo do capitulo do
livro. In Inicial do Nome. Apedido do editor literario do livro (Ed. ou Eds.),
Titulo do livro (pp. xx-xx). Nome do editor comercial.

Exemplo:

Canon, C. L. (2006). Gastrointestinal tract. In J. K. Lee, S. S. Sagel, R. J. Stanley,
& Jay P. Heiken (Eds.), Computed body tomography with MRI correlation (4th
ed., pp. 771-828). Lippincot Williams & Wilkins.

No Mendeley:
Para um capitulo de livro, preencha os seguintes campos:

Type: Book section

Title: Gastrointestinal tract

Authors: C. L. Canon

Book: Computed body tomography with MRI correlation

Year: 2007

Edition: 4

Publisher: Lippincot Williams & Wilkins

Pages: 771-821

Editors: J. K. Lee, S. S. Sagel, R. J. Stanley, Jay P. Heiken (um editor
por linha)

o 0O 0O 0O O O 0O O O

Comunicacdao em
conferéncia

Para uma comunicacao publicada em formato de artigo cientifico, livro ou
capitulo de livro, deve seguir as indicacbes mencionadas neste tutorial para
a respetiva tipologia de documento.

Sessdo / Comunicacao / Poster em conferéncia

Apelido, Inicial do nome do autor. (Ano, Més Dia-Més Dia). Titulo da
comunicagdo [Conference session ou Paper presentation ou Poster
presentation]. Nome da conferéncia, Local.

Exemplo:

Maddox, S., Hurling, J., Stewart, E., & Edwards, A. (2016, March 30-April 2*). If
mama ain't happy, nobody's happy: The effect of parental depression on mood
dysregulation in children* [Paper presentation]. Southeastern Psychological
Association 62nd Annual Meeting, New Orleans, LA, United States*.
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No Mendeley:

Para sessdo / comunicagdo / poster em conferéncia, preencha os seguintes
campos:

Type: Conference Proceedings
Title: If mama ain't happy, nobody's happy: The effect of parental
depression on mood dysregulation in children [Paper presentation]
o Authors: Maddox, S., Hurling, J., Stewart, E., & Edwards, A. (um autor
por linha)
o Proc. Title: Southeastern Psychological Association 62nd Annual
Meeting, New Orleans, LA, United States
o Year: 2016

*Nota: Ao finalizar o documento word, apds quebrar as ligacdes ao
Mendeley, é necessario corrigir trés elementos na referéncia bibliografica:

- no paréntesis do ano, é necessario colocar o més e o dia. Exemplo: (2016,
March 30-April 2) ou (2019, May 20-22)

- colocar italico no titulo da Sessao / Comunicacao / Poster

- retirar o italico do Nome da conferéncia, Local.

Dissertacao de
mestrado e tese
de doutoramento

Apelido, Inicial do nome do autor. (Ano). Titulo da dissertacdo de mestrado
ou tese de doutoramento [Unpublished master’s thesis ou Unpublished
doctoral dissertation]. Nome da Instituicdo que concedeu o grau.

Exemplo:
Almeida, J. M. G. (1999). Ecologia fisiolégica da populacdo de leveduras numa
salina solar [Unpublished doctoral dissertation]. Universidade de Aveiro.

No Mendeley:

Para uma dissertacao de mestrado ou tese de doutoramento, preencha os
seguintes campos:

Type: Thesis

Title: Ecologia fisioldgica da populagdo de leveduras numa salina
solar

Authors: Almeida, J. M. G.

Year: 1999

Genre: Unpublished doctoral dissertation
University: Universidade de Aveiro
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4. GESTOR DE REFERENCIAS BIBLIOGRAFICAS: MENDELEY

O Mendeley é um software que disponibiliza uma versao livre para Windows e Macintosh.

A versdo livre deste programa disponibiliza uma interface web e outra desktop, que sdao de uso
amigavel e intuitivo. Para mais informagdo sobre citagdes e referéncias bibliograficas e sobre este
gestor automatico de referéncias, consulte:

Guia tematico gestao de referéncias bibliograficas: o bom uso da informacéo

Instalacdo do Mendeley

FAQs do Mendeley

Mendeley Help Guides

4.1 Citacoes em texto

Insercao de citagoes em texto:

No Word coloque o cursor no local do texto onde pretende inserir a citacao;

No menu superior References selecione a opcao Insert Citation presente no bloco Mendeley
Cite-O-Matic;

Se o bloco Mendeley Cite-O-Matic nao se encontrar visivel, encerre todos os programas do
Office e, no menu superior Tools do Mendeley Desktop, selecione a opcdo Install MS Word
Plugin, na janela clique em OK.

Nesta janela tem duas op¢des para inserir uma citacdo em texto:
o execute pesquisa nessa janela, selecione a referéncia que quer citar e clique em OK;
ou
o clique no botdo Go to Mendeley presente nessa janela, selecione a referéncia e no menu
superior do Mendeley Desktop selecione a opcao Cite.

No menu superior References selecione o estilo American Psychological Association 7th edition
no campo Style presente no bloco Mendeley Cite-O-Matic;

Caso o estilo American Psychological Association 7th edition ndo se encontre presente na lista,
selecione a opgao More Styles... e, na janela, clique no segundo separador Get More Styles.
Execute pesquisa por American Psychological Association 7th edition, selecione o estilo e
depois clique em Install. De seguida, clique no separador Installed, selecione novamente o
estilo, clique em Use this Style e por fim clique em Done. No documento Word, clique em
Refresh do bloco Mendeley Cite-o-Matic para que o estilo apareca na janela dos favoritos e o
possa aplicar ao documento.
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Insercao de miiltiplas citagées em texto:

Caso pretenda inserir varias citagdes em simultaneo (para casos em que varios autores atestem a
mesma informacgao), devera seguiros procedimentos indicados acima, inserindo as varias citacoes, de
seguida selecione-as e clique em Merge Citations.

Edicao de cita¢oes, apos a inser¢ao no Word:

= Coloque o cursor na citacdo que pretende editar e selecione no menu References do Word, a
opcao Edit Citation presente no bloco Mendeley Cite-O-Matic;

= Na janela, coloque o cursor no Nome do autor Ano (ex.: Silva 2010) para expandir a janela e
ver as opgoes disponiveis;

= Najanela de edicao de citagdes pode acrescentar ou suprimir informagéo presente na
citacdo, nomeadamente:

Page — introduza o numero ou intervalo de niUmero de paginas (ex.: 8 ou 16-34);
Prefix — a utilizar em caso de citacoes de citacdes (as cited in);

o Supress autor — coloque um visto nesta opgao para suprimir a informacgdo da autoria
da citacdo (paréntesis), nos casos em que refere o autor no seu texto (ex: Segundo
Vieira (2020).

4.2 Referéncias bibliograficas

Ativacao da lista de referéncias bibliograficas no Word

= Com o Mendeley, a lista de referéncias bibliograficas ndo é apresentada automaticamente
com a insercao de citagdes em texto;

= Alinsercao da lista de referéncias bibliograficas tem de ser ativada pelo utilizador, sendo que
apos a ativacdo, a mesma sera atualizada a medida que forem sendo inseridas citagdes em
texto;

= Para ativar a lista de referéncias bibliograficas, posicione o cursor no local onde pretende
inserir a lista, selecione no Word o separador References, e no bloco Mendeley Cite-O-Matic a
clique na opgao Insert bibliography.
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Selecdo do estilo bibliografico APA 7ed no Mendeley

No Mendeley desktop, selecione o menu View> Citation style> American Psychological
Association 7ed edition;

No Word, deve ser verificado se o estilo American Psychological Association 7ed edition se
encontra selecionado no campo Style, presente no bloco Mendeley Cite-O-Matic, do
separador References do Word. Caso nao esteja visivel na lista de estilos, siga as indicaces
apresentadas no ponto 4.1 deste manual.

Edicao de referéncias bibliograficas no Mendeley

A edicao e alteracao dos varios elementos (campos) que compdem uma referéncia
bibliografica deve ser realizada apenas através do Mendeley. As alteracdes que efetuar
diretamente no Word nao serdao assumidas enquanto o documento tiver liga¢gdes ao
Mendeley;

Ao selecionar um registo no Mendeley desktop, pode efetuar altera¢cdes na referéncia
selecionada através da barra lateral direita. Para refletir estas alteracdes no seu documento
word, deve clicar em Refresh, presente no bloco Mendeley Cite-O-Matic, do separador
References do Word.

Nota:

= Para algumas tipologias de documento, os campos definidos pelo Mendeley ndo prevém

todos os elementos do estilo em uso. Nestes casos, as alteracbes as referéncias
bibliograficas passam pela quebra de ligagdo ao Mendeley e pela posterior edigdo manual;

= Este processo so deve ser efetuado quando o documento que se encontra a redigir estiver

finalizado;

= No document Word, separador References, bloco Mendeley Cite-O-Matic, selecione a opcao

Export> Without Mendeley Fields;

= Guarde esta versao do documento com outro nome e efetue as alteracdes necessarias

nesta versao do documento.

Ativacao de campos de descricao bibliografica

Se o formulario do Mendeley ndo incluir um dos campos obrigatérios numa determinada
tipologia de documento, pode proceder a ativacdo dos mesmos;

Selecione o menu Tools> options> Document Details, selecione o Document type pretendido
e coloque um visto nas caixas de sele¢do dos campos da lista, clique em Apply e depois em

OK;

Preencha os campos ativados na barra lateral direita do registo selecionado.
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5. TUTORIAIS | MANUAIS

A nova edi¢ao do Publication manual of the American Psychological Association: the official guide to
APA style, 7th edition esta disponivel na versao impressa no fundo documental das bibliotecas da UA.

Consulte mais informacdo de apoio:
APA Style

APA Style Blog

Style and Grammar Guidelines

Instructional Aids

Pordue Online Writing Lab
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